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Save As PowerPoint Package
(Mac only) this choice will create a folder holding all of the referenced sounds, images, and
document files. It is the best solution if you want to make sure your show is portable on a Mac-
to-Mac environment. PC's will view a default font unless the font you used is on the local
machine. Use the option to make the package launch when opened.  You may add the
PowerPoint Viewer 98 to the folder manually (download it first from Mactopia.

Pack and Go
 This is a PC option. It embeds all fonts, making them viewable on any computer, as well as all
files. If possible, use the option to pack with PowerPoint Viewer (you will need to download it
first from the Microsoft Download site).

Print - Save to .pdf
 If you have Adobe Acrobat (full version), Print to pdf (a Mac application) or Mac OSX, you can
save the presentation as a .pdf file. This format is suitable to including in a web page or
distributing for printing. It is an alternative to PowerPoint's own printing options.

Printing
a) In the Print menu, you will be able access PowerPoint-only options. This may be

under a menu labeled "General" or a menu showing text like "Copies and Pages".
Look for Microsoft PowerPoint as a choice. Explore the choices and use the Preview
function.

b) Notes - only what appears on the page will be printed. To print extensive notes, as I
have done here, copy them into a word processing document and print that. Use the
slide number/name as a footer.

Tables : This step is not covered in the workshop because it is self-explanatory. The
directions can be followed independently.

Step 11 - Tables - Slide 16

The Insert-Table option (or use the Insert Table icon in the Standard PowerPoint toolbar) creates
a table similar to those created in Microsoft Word.

1. Column & Rows can be manipulated via the Table Menu that will appear when you click on
the table (View-Toolbars-Tables and Borders).

2. Pressing "tab" in the bottom right cell will create a new row.
3. Cell contents can be formatted by highlighting a range of cells, or formatted in individual

cells.
4. Tables will display text in the default font (unlike text objects).
5. Tables can be animated to appear, but cell contents can not be animated.
6. Images and links can be placed in table cells.
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Step 10 - Publish - Slide 16

Before you publish your presentation, SAVE it. Then SAVE AS… with "2" appended to its
name. That way, you have a backup.

There are many ways to publish and distribute a PowerPoint presentation. Your choice will
depend upon your target audience and presentation method, your version of PowerPoint, and
your hardware platform.  Always save in at least 2 versions!

Choices are:

PowerPoint Presentation
This is the "default" save. Use this if you will be showing the presentation off of your computer.
It is wise to have moved all sounds, images and linked documents into one folder before
beginning the project, but if you have not done so, this method will allow PowerPoint to find
them ON YOUR COMPUTER. Do not use this method for a "traveling" presentation unless you
know that all of the linked and referenced files (including Microsoft Clip Art!) were in the same
folder as the presentation file when the presentation was built. Never move image, sound or
document files after creating a presentation.

Save as Web Page…
Use this method to create a user-navigated "web site" from your presentation slides. Each slide
will be a separate web page. PowerPoint creates a master .htm file (document.htm) and a folder
containing all other files (document_files.htm). Both the file and the folder must be uploaded to a
web server for the presentation to work. There are some options for you: size, navigation, notes,
color scheme and transitions can be somewhat controlled. Overall, however, the show's display
will depend upon the viewer's browser and platform. Animations and hyperlinks will not work
on presentations made on the Mac. Presentations made on pre-XP PC versions should be
reanimated after installing the Animation Runtime Add-in
(http://office.microsoft.com/downloads/2002/msorun.aspx ).  Microsoft Producer is a free
download for PPt 2002 PC that will further enhance web-viewed presentations.

Make Movie
(Mac only) Do not use this! Use instead Save As…PowerPoint Movie.  It is generally best to
accept the default settings. Animations of objects, including sound effects, will be maintained.
Hyperlinks created with Action Buttons and with TEXT will work, but not the invisible button
effects. You will be able to view the show on a web page or on any computer that has a current
QuickTime plug-in. The file size is quite a bit larger than the PowerPoint presentation.

Save as… PowerPoint Show
This creates an actual slide show that can be navigated via the arrow key, self-running, looped  -
it is best for a visual show of slides or a self-timed and automatic presentation. One advantage of
this method is that it will launch into SlideShow view directly from the icon, making it a good
choice for display off of your computer (or if all files can be moved onto a CD or DVD).
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Readdressing an Action Button
2. Navigate to the Quiz slide. The button needs to be adjusted to go directly to the Resources

slide.
• Select the button
• Access the Edit Hyperlink menu: in the formatting palette, by right-click (PC) or ctrl-

click (Mac), by Insert-Hyperlink
• Change the link to: to the Resources slide
• OK

Home Button
Navigate to the last slide.

• Create an Action Button in the bottom center that has the action "home" or "first
slide" - traditionally, it displays a house.

Sound effects can be added to Action Buttons, but I do not recommend this. To add a sound,
right-click (PC), control-click (Mac) and select Hyperlink, OR select the button and then type
ctrl/apple-k. "Play sound" appears as a choice.

SAVE YOUR PRESENTATION.

Organize - Add Transitions - Preview

Fourth, check the order of the slides and create consistent transitions between them. This is done
in the Slide Sorter view.

Slide Sorter
1. Open the presentation in Slide Sorter view.
2. You will see miniatures of all slides.
3.  If there is an extra, unused slide, click on it once. Press delete/backspace.
4. If you want to reorder any slides, do this with the click-and-drag technique.
5. You may, in this view, drag slides from a 2nd presentation into this one, combing the work of

two students or groups into one presentation. (Alternately, use Insert - Slides from File)

Transitions
6. Use Edit-Select All (apple/control-a) to highlight all of the slides.

a. There is a "transitions toolbar" in this view.
b. Open the Slide Transition menu by click on the left-most icon, a miniature slide.
c. Select a "calm and quiet" effect, such as "Cut through to black" or "dissolve"  -

"None" is also a choice
d. Unclick the "mouse click" button - this allows you to use only your buttons for

navigation through the show and prevents you from making a mistake while you are
presenting

e. Click "apply to all"

Test your show, start to finish.  Do this is Slide Show View. Pressing "esc" will bring you back
to Normal view to fix a slide. Correct buttons that are misaddressed (this may have happened
if you moved slides or added slides after creating the buttons). Test all hyperlinks.
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d) Use the Fill tool in the Drawing toolbar to give the text a background color for
emphasis, if you wish.

5. Create the e-mail link:
a) Create another text box
b) In it, type "by yourname: your e-mail address"
c) Add the date if desired
d) Highlight "e-mail address"
e) This time, use either command/control-k or the Insert-Hyperlink command to access

the hyperlink menu
f) At the bottom of the window, enter the e-mail address exactly (capitals count in some

applications)
g) OK

Note: Why put the e-mail address on the slide?  Some users will print the presentation,
see it on the web, or not see it at a machine with a mail program. This method makes
the address available. You could do the same for the web addresses.

Spell-check & Create Navigation

Third, spell-check the presentation. This function is found in the Tools menu.  Be careful not to
ADD a misspelled word to the dictionary.

Fourth, you are going to create a navigation system by making a set of Action Buttons. You have
learned that a symbol or image and text can be hyperlinked. PowerPoint makes it easy to
create symbols, or buttons, to move the user through the show. We will again use Action
Buttons, but you could use any icon or text character as a button. The Internet is a great
source. Try: http://www.iconbazaar.com.  Microsoft Clip Art also has a gallery of icons.

NOTE: By default, a click of the mouse on a slide background will move the user to the next
event and then to the next slide. This will be turned off in our final step.

Basic Action Buttons - review
1. Make an Action Button to take you to the Next slide. To do so:

• Navigate to the Title slide.
• Click on Slide Show - Action Buttons - hold the mouse button down and drag across

and down to "Next Slide".
• Your cursor will be a crosshair. Put it in the lower left corner of the slide. Click down

and drag to create a rectangle. There will be an arrow inside.
• Click OK in the next window.
• If your button is in the wrong place, click down on it and drag it to a new location.
• If your button is too large or small, click on it once. You will see "handles" in the

corners. Use these to resize it.
• To change the fill color of the button, use the Bucket tool in the Drawing toolbar or

the Fill - Color selector in the Formatting Palette.
• Edit-Copy can be used to copy a button to the clipboard. It can then be pasted (Edit-

Paste) onto every slide that needs it. Paste this button on every slide EXCEPT for
(Hint, Correct, No Sorry) and ( the last slide).
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hyperlink. Direct the link to the slide named Resources (don't worry about its location or
number).

Create the Resources listing:
1. Return to the Resources slide (A good way to do this is to "test" the link you just made. View

the slide in Slide Show view and click the link. Press the "esc" key to return to Normal view.)
2. Enter the text of the first resource - Bibliographic citation or other text (such as a web page

title or content summary).

Text as a Hyperlink - External
3. Highlight the text of one Resource to be hyperlinked to a document, web page, or

application.
4. Open the Edit Hyperlink dialogue by one of four methods:

a) Apple/control-k
b) Hyperlink in the Formatting menu
c) Insert-Hyperlink
d) SlideShow - Action Settings…

5. Enter the full URL (http://www.leasttern.com) or the path to the file, application or
document, or the e-mail address (esky@leasttern.com).  These addresses can be copied
directly from a web page. If you have an open web browser, you can Browse to the list of
available addresses in some versions of PowerPoint.

6. OK

Authorship & Copyright Information - Slide 15

Second, all presentations must have a slide containing authorship information and a copyright
disclaimer. This is also where you will grant copy permissions or state your restrictions.

Make a new blank slide. Use Slide 15 as your model.

Copyright Disclaimer

This is the last slide. It should contain an e-mail link to the presentation author if possible, and
MUST CONTAIN a copyright disclaimer. This disclaimer is OK:

This presentation contains adapted copyrighted materials that have
been used under the Fair Use exemption of the U.S. Copyright
Law.

1. Draw a text box on the slide.
2. Enter the disclaimer text (or a similar text in your own words):
3. Highlight and center the text:  Format - Alignment - Center OR use the Alignment and

Spacing tools in the Formatting Palette.
4. Give the text box a border:

a) Select the Text object
b) In the Drawing toolbar, select the Line Style icon (3 parallel lines) - select a border

width
c) In the Drawing toolbar, click the down arrow by the Line Color tool (pencil) - select a

color
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HINT: Create one circle. While it is selected, use Copy/Paste to duplicate it twice.
Drag the copies (they are on top of the original) into place. Select each
individually to recolor it.  You can also make an exact copy of a shape by clicking
it once then dragging while you hold down the option (Mac) or ctrl (PC) key.

c) Create a new slide for the Hint. It should have text that answers this question: What
trick do you think is most useful? Make again or copy the Action Button back to the
Quiz (or last slide viewed).

d) You DO NOT NEED INVISIBLE BUTTONS when you have shapes to click on.
Make the links by clicking on the button and the selecting Insert-Hyperlink.

1. Direct the 2nd circle to the "Sorry" slide.
2. Direct the 3rd circle to the "Hint" slide.

ScreenTips
e) Click on the first circle. While it is selected, access the Edit Hyperlink menu

(apple/control-k). Click the "Document" tab. In the "anchor" bar, enter # .  Click on
the ScreenTips button. Enter some text here to see how it works. The Tip will
"popup" in Slide Show view or in a web version of the presentation.

Note: if the action button on the Correct or Try Again slides had been Previous, they would
not have worked! The minute you jump out of linear linking, you will need to direct your
links to specific slides.

Step 9 - Hyperlinks, Resources, Copyright - Slides 13-15

Review:
1. Why is slide hyperlinking better if it does not use Previous and Next as actions?
2. How can you create an "invisible button"?
3. What are some classroom applications of the Quiz format?

a) Students can make quizzes to check their understanding of the reading (rotate as HW)
b) Presentations can contain quizzes
c) Maps and vocabulary lessons for foreign language can be presented this way (click to

read more, click to find an answer)

Slide 13 shows you the "Final Touches" for a slide show. Completing them in this order will
force students (or you) to focus on the most important aspects first. If the last two touches are
not completed, the slide show will not suffer.

Resources/Bibliography - Slide 14

First, most project slide shows will require a bibliography. Lacking this, there can and should be
a list of Resources (online, print, other).  For the purpose of this show, I have used a
Resources list. A list like Final Touches can also be the Contents slide for the presentation.

Text as a Hyperlink - Internal
1. Text can be a hyperlink. To create a link to a Resources/Bibliography slide, first create a new

slide.
2. Title it Resources. Return to the Final Touches slide.
3. Highlight the text, "Resources"
4. Use either the Insert - Hyperlink, command/control-k, or the Formatting Palette to insert a
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4. Click onto the slide and draw a rectangle in the bottom left corner.
This will create a button that is set to hyperlink when clicked to "Last
Slide Viewed"

5. Resize the button if desired using its handles.
6. Change the fill color if desired using the Fill tool (bucket).

7. Create a new blank slide that says: "No, sorry. Try again."
a) Use text formatting to make this look interesting.
b) Also create an Action Button for this slide with the "Last Slide Viewed"

Action
c) NOTE: Is there a quick way to create this action button, since you have

already made it once? Yes, buttons and their link effects can be copied and
pasted!  The reason for selecting this action will become apparent when you
finish this slide: linking to "previous" would go to the Correct! slide, not the
quiz slide.

8. Return to the Quiz slide using the Outline View or the double-arrows on the slider
bar.

Invisible links
9. Link answers to the Correct or No, Sorry answer slide: Allow 5 minutes for this task:

a) In the Drawing toolbar, select the rectangle tool. Draw a rectangle over the
letter of the correct answer.

b) Your box will be a color and have a border. You need to make both invisible.
c) With the box selected:

1) Click the tool in the Drawing toolbar that looks like a paint bucket.
Select "No Fill"

2) Click the tool that looks like a pencil/brush. Select "No Line"
d) With the invisible box still selected, Click on Hyperlink in the Formatting

Palette (or use Insert-Hyperlink or use apple/control-k) - using the Formatting
Palette is the easiest method

1) Select: On mouse click:  and select Slide...
NOTE: if you "lose" the invisible button, move your cursor in the area of
the button and click when it becomes a "hand"
2) Navigate to the "Correct!" slide - it may be identified only by its slide
number
3) Return, Enter, OK

10. Link to the incorrect answers:
a) Repeat the above procedure for the 2 incorrect answers, linking to the "Sorry"

slide.
b) The "invisible button" can be copy-pasted.

Create question #2. Allow 5 minutes for this task.
1. Create text box that says: "Select the dot with the hidden hint!"

Autoshapes as links
2. Using the Autoshapes tool in the Drawing toolbar (it looks like 3 little geometric shapes):

a) Draw 3 circles. Hold the Shift key to make them all maintain the circle shape.
b) Use the Bucket / Fill tool to color the circles: red, green, blue.
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9. To create box 6,
a) Use the box tool to draw a box in the position shown
b) Select the T (text) tool and draw a text object inside of the box
c) Enter the text shown. Use the Text menu to align it to the Center.

10. To add the lines, use the diagonal and straight line tools. Draw the line from the border of
Box 6 to Box 1-5.

11. Format the line using the Line menu.

When you are done, Select File - Update and Return to MyProject.ppt

Press enter if you are asked to save the update.

Create a new slide. Use the Title Only format again. You are going to learn to make invisible
links, text hyperlinks and ScreenTips.

Step 8 - Interactive Links, Shapes - Slides 9 - 12

Review:
1. What are some useful reasons to use the Organization Chart layout?
2. What are some reasons not to use it?

In this lesson, you will create a simple quiz. The first question will use a standard format. The
second question will use a graphical format.

Title the slide: PowerPoint Quiz

Setting up an Interactive Quiz
Create Question 1. - 5 minutes
1. Draw a text box.
2. Enter the follow text above the bullet: What is my favorite thing about PowerPoint?

Return/enter
3. Enter the following directions: Click on the letter of the correct answer. Return/enter
4. Enter the following letter-formatted points as answered:

A. It is easy to use.
B. It does not require a lot of typing.
C. It is fun.

5. Decide upon the correct answer.

Action Buttons
6. Create a new blank slide that says: "Correct!" (In WordArt)

a) This slide will need a button that returns the player to the Quiz slide.
b) Create an Action Button -

1. Select Slide Show - Action Buttons
2. Select "Last Slide Viewed"(Mac) or "Return" (PC) from the menu
3. The Last Slide Viewed Action button will automatically return you to

the quiz. A safer method would be to redirect the link directly to the
Quiz slide.
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Using Layered Objects in Animation

Draw a next text box ON TOP OF the WordArt object. In this box, write a title: When should
WordArt be used?

Answer this question with three bullet points or numbered points.
Allow 5 minutes to type and format this list.

Animate the list to appear BEFORE the WordArt object then disappear AFTER the WordArt
disappears.

1. To do this, you will need to first animate the text object with an Entry Effect.
2. WordArt will need an EXIT effect, occurring 2 seconds after it enters the slide (previous

event). (older versions do not have this feature)
3. Then, in the Order and Timing tab, move the text object's Entry icon above the WordArt

Entry icon:
a) Select it with one click
b) Click the up arrow

Challenge: Add a 2nd text box that will appear after the WordArt animation.
a) Title it: Dangers of Word Art.
b) Use the Animation choices in the Formatting Palette to animate this object.

Make a new slide. Use the Organization Chart option.

The Workshop will omit the following step - Directions can be followed independently if
desired.  We will briefly discuss the contents of Slide 8.

Organizational Charts - Slide 8

We will use this layout to create an organizational chart to summarize the steps to creating a
successful group PowerPoint project.  This layout can also be used to storyboard a
presentation or project or to set up a web site.

Title the slide: Organizational Chart Sample

Note: 5 is the number of boxes that will fit effectively across a slide.  You will need to shrink the
object after completing the editing. On a PC, you may have other choices: a Venn diagram, a
flow chart, a pyramid or triangle diagram.

To create the chart:
1. Double click in the chart place-holder
2. In the default view that shows, click into the top text row of the top box.
3. Enter text as shown or as directed in the workshop.
4. Unused lines of default text will not appear in the final product.
5. Repeat for the first 3 Subordinate boxes.
6. To create box 4, click on the Co-Worker icon. Click 1st in box 3, then drag across to the left

to create a new box.
7. Repeat to create Box 5.
8. Enter text as indicated on the model slide (8).
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Here are some guidelines:

1. If you have a picture or movie saved on your drive, select the Picture and Text option.
2. If you want to insert Microsoft Clip Art, your best option is to use a blank or title only slide.
3. If you want to insert a picture via copy/paste, use a blank or title only slide.
4. If you want to insert a picture using the "Insert Picture from File" icon in the Drawing

toolbar, use a blank or title only slide.

Review:
1. How do you access Microsoft Clip Art?
2. How do you create a text box object?
3. What steps do you take to animate the objects on a slide?
4. How do you preview slide animation?

In this lesson, we will create a Word Art object and animate it.

Title this slide: Word Art

Creating a WordArt object
1. Click anywhere in the slide's blank area.
2. Select Insert - Picture - WordArt (or click the Insert WordArt icon in the Drawing toolbar)
3. Select any one of the layouts from the Gallery.
4. In the window that appears, type your text.  Type: Kids Love WordArt!
5. Click OK.
6. Your image appears. It will appear in the shape, font and color of the Gallery choice.
7. This is an object. It can be resized with its handles.

Formatting WordArt
To change this:
1. Double click on the WordArt object. In this menu, you can change the font and font size.

NOTE: font choices will vary - the choices depend upon fonts installed on the machine.
2. Click once on the WordArt object. A small editing menu will appear.

a) Return to the Gallery to redraw the object if you wish
b) Format the object:

a) Change the fill color
b) Change the transparency
c) Change the outline line color
d) When you click Preview - you can see how the change will look
e) Click OK when you are done - you will have to reclick the object to make

further changes.
c) Change the Shape of the object. Further change the shape by resizing with the

handles.
d) Rotate the object - drag from the circular handles.

Allow 5 minutes to make your WordArt perfect.

Animate it to enter the slide in a way you have not yet explored, on a mouse click. Because it is
an object, it will be called "Shape."  Also because it is an object, you can use ANY FONT.
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To do so:
1. Open Slide Show - Animation - Custom (or Custom Animation)
2. In the left window, click on the image identifier (will vary, but usually contains the word

Picture)
3. In the right window, set the Entry Effect to: Swivel
4. Set the Entry Sound to "Applause".
5. In the Order and Timing tab, click Automatically - Enter 1 second
6. Click on the Text identifier (varies, but usually contains the word Text)
7. In the right window, set the Effect to your choice. "Appear" is the most often used (that's

why it is first).
8. No sound here!
9. In the Order and Timing tab, set the animation to "Automatically" and "1" (make sure the

text box is highlighted in the list at the top of the window) - we are doing this because the
"mouse click" option will be turned off for the entire show. This creates a slight pause.

10. In the Options tab, set the bullets to be "grouped by 1st level".
11. Click on Play to preview.

To preview the REAL animation, Click OK. Open the slide in Slide Show view by clicking on
the Slide Show icon. Remember that you have set the animation to show the text with a
mouse click!

To add a sound object, use the Insert-Movies and Sounds menu.
1. There are sound effects throughout your computer as well as in the ClipArt Gallery. Click

Insert - Movies and Sounds - Sound from Gallery and select an Animal sound.
2. Look for sounds on the Internet, in HyperStudio, in MicroWorlds, and (on a PC) in the

System folder.  A search for *.wav will yield a list of "wav" files. Similarly, look for *.aif,
*.aiff (Mac), *.mp3, *.mov (these are QuickTime sounds).

3.   A sound object can be animated in many ways. The icon can be hidden or it can be displayed.
Experiment with the options.

At this point, return to slides 2 and 3. Animate the text objects. Return to slide 4. Animate the
chart (by element in series) using the Options. The chart should be given the entry of
"appear" automatically. Allow 10 minutes to this task.

Make a new slide. Select the Title only slide again.  SAVE YOUR PRESENTATION.

Step 6 - WordArt - Animation Effects - Slide 7

A Note About Layout Options
Why are we selecting Title only instead of the other options?
Find the answer:

1. Change the layout choice of this slide by selecting Format - Slide Layout. Select one of
the Picture and Text options.

2. Double-click as directed on the picture place-holder. You are sent into your hard drive to
find a picture. This complicates the process.
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Step 5 - Images, Text Objects - Animation - Slide 6

Review:
1. What are 3 ways to put a chart onto a PowerPoint presentation?
2. What is the general principle behind formatting a chart created within PowerPoint?
3. What is OLE and when is it useful?

In this step, we will add a picture to a slide, describe it, and animate the slide.

First, title the slide: A Picture is Worth a 1000 Words

Inserting Clip Art or a Picture - Minor Formatting
Use the Insert - Picture - Clip art menu commands to access the Microsoft Office clip art library.

OR use Insert - Picture from file. Navigate to the Clipart/Photographs folder inside of the
Microsoft Office folder on your hard drive.

1. Take exactly 2 minutes to locate a picture that carries meaning for you.
2. Click the Insert button.
3. The image will be selected. Drag it to the left or right of the slide. Resize it if necessary so

that you can insert a column of text on the other side.
4. If you want to move the image, click it when your cursor changes into a hand - then drag.
5. Resize the picture if necessary using its handles.

Note: If you hold shift while resizing, the image will not be distorted.
Note 2: You can also insert clip art using the "Insert Clip Art" icon in the Drawing

toolbar. It looks like two images overlapping.
Note 3: Use the" Insert Picture from File" icon in the Drawing toolbar to search

for a saved picture or movie file.

Another Text Box
Create a text box:
1. In the Drawing menu, select the Text Box icon (an A with an I-beam cursor).
2. Your cursor will turn into an A with an I-beam. Draw a rectangle on the slide in which to add

text (it will appear large, then close to allow the first line of text).
3. This text box is also an object: it can be moved, resized, deleted, hidden, animated or

overlapped.
4. In the Formatting Palette, select a font size and font (it should match your title font!)
5. Type - "This picture represents:"

a) Subtopic
b) Subtopic
c) Subtopic

6. Use bullets or numbers as you wish.

Slide Show Custom Animation - Motion & Sound
Animate the picture and text. First have the picture swivel in to "Applause". Then have the text

appear automatically by a method of your choice. This is an area in which your version of
PowerPoint may have somewhat different directions - however, the net effect will be the
same. SIMPLE IS BEST.
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The Workshop will omit the following step - Directions can be followed independently if
desired.  We will briefly discuss the contents of Slide 5.

Linked Excel Spreadsheet - Slide 5

It is also possible to link directly to a chart created in Excel. This is called an OLE link. This will
allow you to alter data in real time as you present the show, changing the Excel document as
well. To do so, create a new slide using any method. Select the blank layout.

1. If you already have an Excel document
a) Change the location of the chart so that it is on its own Chart Sheet (select the chart -

click Chart-Location)
b) I recommend that you add a data table to the chart (Chart-Options - Data table)
c) In the PowerPoint presentation, select Insert-Object.
d) Select Microsoft Excel Chart.
e) Click the button "create from file"
f) Navigate to the Excel document.
g) Be patient - a small version of your chart will appear on the slide. This can be resized

with the handles.
2. To create a chart from scratch inside of Excel (this will allow you to use all of the Excel

functions):
a) On a blank slide, click Insert-Object
b) Select Microsoft Excel Chart
c) A reduced Excel window will open, showing a ChartSheet and as sample chart.
d) Click on the tab labeled Worksheet 1 to access the sample data. This can be changed

and reformatted.
e) Reformat the chart itself by working within the ChartSheet. (see methods for

formatting a PowerPoint chart - they are the same).
f) When you are done, save and quit Excel. The file is ALREADY NAMED. The chart

will appear on your slide.
3. To access the EXCEL DOCUMENT in real time,

a) If it was created within PowerPoint - (2) above - you just need to double click the
chart itself.

b) If you are linking to a file saved on your computer,
1) Repeat the Insert - Object - Microsoft Excel Chart, this time selecting "from

file"
2) Navigate to the Excel file.
3) Click the button next to "display as icon" - OK
4) It will be necessary to make this icon into a hyperlink if you are using a Mac.

If you are using a PC, clicking it will open the Excel document. To make the
link, click once on the icon. Select Insert-Hyperlink. In the lower half of the
window, "Select" the file by browsing your hard drive for the document. OK

5) Double click on the icon on the slide. The original worksheet will open. You
can then make changes as you work.

SAVE YOUR PRESENTATION.
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Formatting the Chart
Format the sample chart:

There are many chart options in terms of appearance.  Students will try to be very fancy.
Exert control over the effects by including a separate evaluation of the chart in your
assessment.

Double-clicking on a chart will open the datasheet in Edit view so that its appearance can
be further changed.

1. Click on the Chart Preview to make it the top window.
2. To change color sets and other appearance details:

a) Double click directly into one of the color bars - click on a new color in the palette to
the right.

b) Avoid gradient fills (memory hogs) and unnecessary shading.
c) To add a border or background color, or change fonts, double-click into the

background of the chart.
d) The chart title is an object. You can click into it in the chart preview and resize it or

change its color.
e) Double-clicking any one of the axis labels will open a dialogue to change these

labels. The right-most tab changes alignment (useful for science data labels).
3. To add a data table at this point, you can click directly on the data table icon in the Chart

toolbar.
OR make more changes:

4. Open the Chart Menu.
5. Work DOWN the menu options.
6. First select Chart Type. Selecting an options will change the chart preview. You can change

this again at any time.
7. Second select Chart Options.

a) Work from left to right across the tab menus.
b) The most important options are the Titles and Axes.
c) You can change your decisions at any time.

8. Click onto the slide itself to leave Chart edit view. This view is actually a separate program
called Microsoft Graph. You can leave by quitting the application. This is recommended for
the Mac environment.

To change the width or height of the chart, select it in Normal view. Drag by the handles.
Add a border to the chart by clicking on the chart, then on the "Line Color" (pencil or brush) tool

in the Drawing toolbar.

Charts can also be inserted via copy-paste ( from spreadsheet or graphing programs, or from web
sites such as Chart Maker). In the new Mac and PC environments, they can be inserted via
click-and-drag from an open application.

Make a new slide, using the Title only layout.

SAVE YOUR PRESENTATION.
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a) Use the Outline menu icon to create the "Demotion" of the subtopic.
b) Return after each entry.

Formatting Bullets
Return to Normal view.

1. First, we will change the bullet styles for the presentation. To do this:
a.  Open the Slide Master and click into the First (top) level of bulleted text
b. Click on Bullets and Numbering in the Formatting Palette. On a PC, right click

next to the bullet itself.
c. Next to Style, click on the down pointing triangle. (Mac)
d. Select "character (Mac)" or Custom (PC)
e. You will enter a visual display of fonts. Select Webdings in the " Bullets from…"

menu.
f. Select any icon. Clicking once on it will enlarge your view.  Click OK.

2. Change the Second level icon as well if you wish. Try the Wingdings listing.
3. Return to Normal View.
4. NOTE: if you wanted to use the same bullet style for all levels, you could do so using

only the Format - Bullets and Numbering…. menu

View - Normal. SAVE YOUR PRESENTATION.

Make a new slide using the  keyboard shortcut: control-m. Make this a Title and Chart slide.

Step 4 - Charts & Graphs - Slides 4 & 5

Review:
1. What are 3 ways to make a new slide?
2. How can bullet style be changed for the entire presentation?
3. In what toolbar will you find the bullet styles?

The purpose of this card will be to create a chart of an informal survey.

Title the slide: Sample Survey

The Datasheet
As the slide directs, double click to add the chart. Directions:
1. If the datasheet is behind the chart preview window, click on it once to bring it to the front.
2. Add your own data to the datasheet

a) We will do an informal survey of footwear
b) In the Left column, change the heading next to 1-3 to: Shoes, Sneakers, Sandals
c) Change the top row headings, B-D to: Men, Women, Both
d) To delete columns or rows,

1. Click into the column or row header (1,2,etc. or A,B,etc.) to highlight the row
or column

2. Select: Edit-Delete (or right-click Delete on a PC)
e) We will enter the data from the workshop group
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Formatting a Text Box
6. Create a second text box

a) Use Insert - Text box OR click on the Insert Text box icon in the Drawing toolbar.
b) Your cursor will change to an A with an eye-beam. Use this to draw a box under the

list.
c) Type this: "Sample text"
d) Notice that you will need to format the text font and style - this will be true when you

add a text box that is not in the layout template.
e) Reshape this box by dragging from its handles - practice this.
f) Move the box by clicking down and dragging when the cursor is shaped like a hand.
g) Give the box a border. To do so, select the box. Click on the "Line Color" tool in the

Drawing toolbar - select  a color from the boxes shown (these represent the COLOR
SET for your presentation)

h) Give the box a background color - Click on the "Fill Color" (bucket) tool in the
Drawing toolbar - select a color

i) Delete the text box. First, select it (click once on the text itself):
1) If the border is horizontal hash marks, click it once. The border will change to

dots. Press Delete/Backspace.
2) If the border is dotted, press Delete/Backspace (if nothing happens, follow the

previous step).
7. Make a new slide using the icon method

a)  Click on the New Slide icon in the Standard toolbar (it is a slide with a plus sign on
it)

b) The slide should again be a bulleted list.

Step 3 - Outline View, Bullets and Bulleted Lists - Slide 3

Review:
1. What is a bulleted list? When would you select this layout?
2. How do you change a bulleted list into a numbered list?
3. How can you add sub-text?
4. How do you add the correct prefix (a,b,c) to a list?
5. How do you move a text box?
6. How can you expand or shrink a text box?
7. How can you add a border and a background color to a text box?

Caution - Click exactly where you want to be. Be aware always of Handles and Selection
Rectangles and Selection Borders.

Outline View
For this section, we will work in Outline View.
1. Open Outline View
2. Click onto Slide 3. It will highlight a little bit.
3. Add the title text: What We Want to Learn
4. Press return, then press the "Demote" (or move right) icon on the Outline toolbar. It shows an

arrow pointing right.
5. The workshop group will again generate the content. Press return after each entry.
6. We will make one set of subtopics: "Fun stuff:"
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Slide Design
9. Click onto Format - Slide Design - allow only 5 minutes for this task!

a) If there is a design that pleases you, good. Apply it. Notice that your font and color
choices have changed.

b) Additional design templates are available at the Microsoft Download center
(http://office.microsoft.com/downloads ) or Mactopia
(http://www.microsoft.com/mac/resources )

Slide Color Scheme
10. Click on Format - Slide Color Scheme.

a) Click on Custom.
b) Ignore the Background color. Change Color of the other items so that they will appear

as you wish on your slides.  The bottom two choices affect your hyperlinks.

THESE DECISIONS CAN BE CHANGED AT ANY TIME! You may, however, have to return
to the master slide to reassert some decisions.

SAVE YOUR SHOW - name it "MyPowerPt" - if you are a Mac user, the extension .ppt must
be appended.

1. Make a new slide by Insert - New Slide.
2. Select Bulleted List from the Layout menu.

Step 2 - Numbered Lists, Text Boxes - Slide 2

Review:
1. What are the Essential Toolbars for working with PowerPoint?
2. What is the purpose of the Slide Master?
3. In what menu will you find options to alter slide appearance?
4. What is one way to create a new slide?

Working on the new slide:
1. Add this title: What We Know

Numbered Lists with Sub-Topics
2. We really want a numbered list. Use the Formatting Palette to change this:

a) Open Bullets and Numbering
b) Click on the left icon - it shows a numbered list.

3. Type the first point:  Students use it for…
4. Type the second point: Adults use it for…
5. We will add sub-content to the list as it is generated by the group.

a) Use the Formatting Palette to add sub-points and change point styles - you will want
your sub-points to be a.) b.) etc. - you will need to change the bullet/number style or
"start at" value

b) Use the Formatting Palette to shrink the space between bullet points (if PowerPoint
does not do it automatically)
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Step 1 - Toolbars, Views, Formatting Options, Slide Master -
Slide 1

For this part of the Workshop, you will be following these directions to create your own slide
presentation. The slides illustrate the outcome of the direction steps. Animations and
transitions will not be displayed. Depending upon your platform and your version of
PowerPoint, some directions will be slightly different from those given. Explore the menus if
you are confused.

Open a New Blank Presentation.
1. Select the Title Card Layout.
2. Your title is:  Exploring PowerPoint
3. Change the subheading to contain your name.

Showing the Toolbars
4. Open the Essential for PowerPoint Toolbars:

a) Edit - Formatting Palette (Mac platform) OR Edit-Toolbars-Formatting AND Task
Pane  (PC platform for older versions)

b) Edit - Toolbars - Standard,
c) Edit - Toolbars - Drawing,
d) Edit - Toolbars - Outlining (accessible only when you are "clicked into" the outline)

Formatting the Presentation
5. Make some initial decisions about colors and fonts:

Slide Master
6. Open View - Master - Slide Master.

a) Change the Title and body text to Trebuchet MS.
NOTE: This font is on both PC and Mac computers. Others are: Times New Roman
(good for text), Arial, Comic Sans MS, Courier New, Garamond, Georgia, Impact,
Tahoma, and Verdana. PowerPoint will default to Arial or the font specified by a Design.
b) Give each a text color. I recommend that you not change the font size.
c) Select View - Normal OR click "Close" on the floating control bar

Slide Background
8. Select Format - Slide Background - allow only 3 minutes to this task! (you can change it

later):
a) Click onto the horizontal bar under the slide miniature. Select Fill Effects.
b) Click on the Texture tab. Select a Texture.
c) NOTE: any tiled graphic can be used as a texture. You can find textures on the

Internet.
d) Click Apply to All
e) NOTE: Do not click the button "Omit background graphics from Master" unless you

do not want the Slide Master to control such things as navigation buttons - this is not
recommended.
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Essential Skills for PowerPoint:

1. Identify your version of PowerPoint; locate and launch the PowerPoint application
2. Click-and-drag - to move, to highlight
3. Double-click
4. Single click to select
5. Navigate an application menu - select from menu choices
6. Navigate computer file structure to save into a "safe" folder or directory
7. Navigate computer file structure to locate a "helper" file, such as a sound or image
8. Locate and use the Help menu (PowerPoint Help)
9. Use the Search or Find command to locate files on the computer
10. Use the menu and/or toolbar to format text and objects (font face, color, size)
11. It is recommended that the following keyboard shortcuts be used comfortably:

a. Apple/control - s
b. Apple/control - c
c. Apple/control - v
d. Apple/control - z
e. Apple/control - b
f. Apple/control - a
g. control - m (both platforms)

Workshop Vocabulary:

1. normal view
2. outline view
3. slide sorter
4. slide show view
5. slide master
6. standard toolbar
7. formatting toolbar - task pane
8. outlining toolbar
9. drawing toolbar
10. alignment
11. slide show menu
12. extension
13. action button
14. hyperlink
15. image
16. symbol

Important Considerations:

1. PC or Mac?
2. Version of PowerPoint
3. Target: audience & presentation venue
4. To print or not to print
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The Goals:
1. To make participants comfortable with the creation of a basic PowerPoint presentation.
2. To excite the participants about PowerPoint and its uses in the classroom.
3. To provide a basis for further, independent exploration of PowerPoint.

Slide numbers refer to slides on the Exploring PowerPoint Handout (yellow).
Additional information can be found on the PowerPoint in the Classroom handouts (blue).

The directions are repeated, for the most part, in the Notes appended to the Exploring
PowerPoint presentation. It is available for viewing online:

http://www.leasttern.com/workshops/PowerPt
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